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Welcome to Microsoft Office 2010 for Windows: 

Visual QuickStart Guide. In the pages that fol-

low, you’ll find the information and instruc-

tions needed to quickly become productive 

with the key applications in Microsoft Office.

Like other titles in the Visual QuickStart 

series, this book was written primarily as a 

reference. Unlike a book on a single program, 

however, this one covers four major applica-

tions: Word, PowerPoint, Excel, and Outlook. 

Rather than discuss every command and 

procedure in excruciating detail (as you’d 

expect in a one-program book), this book 

focuses on the commands and procedures 

you’re most likely to actually use.

Introduction
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How This Book Is Organized
To make it easy for you to find the information 

you need at any given moment, the book is 

divided into major sections called parts. 

◆ Part I describes the changes you’ll find in 

Office 2010 and provides an introduction 

to essential Office procedures. Certain 

tools and features (such as using the new 

Backstage, working with graphics, and 

creating charts and tables) work the same 

regardless of the Office program you’re 

using at the moment. Rather than repeat 

this material for each application, I present 

it in Chapters 2 and 3.

◆ Parts II through V are devoted to the 

individual Office applications—one part 

for each application.

◆ Part VI provides an introduction to the new 

Office Web Apps. Using them, you can view, 

share, and edit Office documents with most 

current Web browsers.

Table i.1

Microsoft Office 2010 Suites
O f f i c e  A p p l i c a t i o n s H o m e  a n d  S t u d e n t S t a n d a r d † H o m e  a n d  B u s i n e s s P r o f e s s i o n a l P r o f e s s i o n a l  P l u s †

Word ◆ ◆ ◆ ◆ ◆

Excel ◆ ◆ ◆ ◆ ◆

PowerPoint ◆ ◆ ◆ ◆ ◆

Outlook ◆ ◆ ◆ ◆

OneNote ◆ ◆ ◆ ◆ ◆

Publisher ◆ ◆ ◆

Access ◆ ◆

Office Web Apps ◆ ◆

† The Standard and Professional Plus suites are available only via volume licensing.

Which Suites Are Covered?
Microsoft Office 2010 is available in five 

configurations (or suites), each with a different 

combination of applications (Table i.1). With  

the exception of the Home and Student suite, 

each suite includes the four core applications 

discussed in this book: Word, Excel, Outlook, 

and PowerPoint.

✔ Tip

■ For a solid primer about an earlier version 

of Microsoft Access, you might want to 

pick up a copy of Microsoft Office Access 

2003 for Window: Visual QuickStart Guide, 

written by yours truly.
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The Office Applications
If you’re unfamiliar with any of the programs 

covered in this book, the following pages pro-

vide a quick overview of the tasks for which 

each one is suited.

Microsoft Office Word 2010
Word is a word-processing program. You can 

use it to write letters, memos, contracts, 

reports, or the Great American Novel. Because 

Word is so commonly used in the business 

world, you’ll find that most word-processing 

documents you receive from others will be 

Word files.

Like other word-processing programs of the 

past twenty years, Word uses a WYSIWYG 

(What You See Is What You Get) approach to 

document formatting, layout, and display. 

That is, the fonts, paragraph formats, margins, 

and page breaks you see onscreen will precisely 

match those in the printout. 

If your needs go beyond simple text docu-

ments, you can embellish them with tables, 

clip art, and photos. You can also apply stylish 

3-D effects called WordArt to text and insert 

important titles or bulleted lists as eye-catching 

SmartArt. 

In addition to allowing you to create new 

documents from scratch, Word provides 

an array of templates for useful documents 

and forms. Many can be used as-is or with 

only minor modification. And if you want to 

generate personalized mailings, Word has a 

mail merge feature.

Microsoft Office Excel 2010
Like Word, Excel is the most widely used 

spreadsheet application around. You can use 

a spreadsheet program to enter, analyze, and 

summarize large amounts of numerical and 

text data on a row-and-column grid. 

Excel is an excellent tool for performing 

calculations (via formulas and its built-in 

functions), as well as for creating colorful, 

informative graphs. And because so many 

people use worksheets to record lists, Excel 

also includes list-management features. 

The days of the drab, colorless, single-font 

worksheet are over. Excel supports mixed 

fonts, styles, colors, and rotated text, as well 

as cell background and conditional format-

ting. To further embellish any worksheet, you 

can add clip art, pictures, predefined shapes 

(such as arrows and text balloons), WordArt, 

and SmartArt.

Microsoft Office PowerPoint 2010
PowerPoint is Office’s “best in class” program 

for creating presentations: slide shows with 

between-slide transition effects, within-slide 

animations, recorded audio narration, pre-

senter notes, and handouts.

To give your slides a consistent, professional 

look, you can select one of the included themes 

or download others from Office.com. You can 

also create and save templates that include 

designs and other key elements, such as a 

company logo or address information.

After you’ve rehearsed and set the timing for 

your presentation, it can be played on a com-

puter, professionally output to slides, or used 

to generate a Web-based presentation.
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Microsoft Office Outlook 2010
Outlook’s primary function is that of an email 

client. Outlook can send, receive, and manage 

email for all types of accounts (including 

certain Web-based ones, such as Hotmail 

and Windows Live). Outlook 2010 can also be 

configured to receive Really Simple Syndication 

(RSS) message feeds.

In addition to providing email capabilities, 

Outlook can serve as your business and home 

calendar (allowing you to record and schedule 

reminders for upcoming appointments, 

meetings, and other events), handle your to-do 

list, and manage work and personal contacts.

How to Use This Book
This is a book for beginning to intermediate 

users of Microsoft Office for Windows. If 

you’re using Office for the first time or already 

know the basics but want to get more out of 

your investment in Office, this book is for 

you. If you learn better from step-by-step 

instructions and lots of graphic examples than 

from reference manuals that just describe 

what the commands do, this book is also for 

you. Most of all, if you know what you want 

to do and want to get started in the shortest 

possible time, this book is definitely for you.

I’ve worked hard to create a book that will let 

you turn to the directions for any procedure, 

learn what it does, and then do it yourself. A 

screen shot illustrates every significant step. 

The goal is to give you all the information you 

need and little that you don’t, making you 

productive as quickly as possible. Along the 

way, you’ll find tips that offer helpful informa-

tion about many of the procedures.

About the Author
Since modern man shoved aside the type-

writer in favor of a keyboard, I’ve been 

writing computer articles and books. (I was 

going to say “Since the dawn of time…,” but 

thought it would be a bit much. Thirty-two 

years of computer-industry writing is a long 

time, though!) My first computer book was 

published in 1984, and I’ve written 50+ titles 

since then. This may not make me the first 

computer book author or the most prolific, 

but I must be close on both counts.

My background includes computer periodi-

cal/book Editor-In-Chief, as well as Technical 

Services Director for a software company. I 

also have a Ph.D. in psychology that I don’t use, 

but the diploma makes a nifty wall hanging.
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Microsoft Office Word is a word-processing 

application—perhaps the most widely used 

word-processing application in existence. 

You can use Word to write letters, memos, 

reports, and essays. Because it is so perva-

sive and allows you to save in a variety of file 

formats, there’s an excellent chance you can 

create a version of a given Word document 

that can be opened by almost any recipient.

In this introductory chapter, you’ll learn 

about the Word interface, working in dif-

ferent views, and entering and editing text. 

For information on launching and quitting 

Word, as well as performing basic document-

related tasks, such as creating, opening, sav-

ing, and closing documents, see Chapter 2.

✔ Tip

■ Every Word document—whether new 

or opened from disk—opens in its own 

window. Clicking a document’s close  

box (X) closes only that document. To 

close all documents and quit Word, you 

must individually close every open docu-

ment or click the File tab and click Exit in 

the Backstage.

Getting  
Started with  
Word 2010
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The Word Interface
Figure 4.1 (below) shows the interface ele-

ments you’ll use when creating and editing 

Word documents. Many, such as the Ribbon, 

File tab, and Quick Access Toolbar, can also 

be found in Excel, PowerPoint, and Outlook.

File tab. Click this tab to perform file-related 

activities in Office Backstage (Figure 4.2), 

such as creating, opening, saving, and print-

ing. Click Options to set Word preferences. To 

open a document on which you’ve recently 

worked, click its name in the Recent list. The 

Exit command can also be found here.

Quick Access Toolbar. Icons for common 

commands (such as Save, Undo, and Redo) 

can be found on this customizable toolbar.

View Ruler

Help

Zoom controls

Close

Scroll bar

Scroll box

File tab Quick Access Toolbar Tab (View) Group (Styles)

Document

Styles pane

Ruler

Office Clipboard

Ribbon

Figure 4.1 Elements of the Word 2010 interface.

View controlsPage Proofing errorsWords

Figure 4.2 When printing the current document in the 
Backstage, Page Setup options and a print preview 
are automatically displayed.
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Help. Click this icon or press 1 to open the 

Word Help window (Figure 4.3).

Ribbon. The Ribbon is Office’s replacement 

for the program menus found in Word 2003 

and prior versions. Similar commands and 

procedures are listed together on a tab, such 

as Insert or View. Within each tab, procedures 

are further divided into groups, based on 

similarity of function. To perform a command, 

you switch to the appropriate tab by clicking 

its name and then click the command’s icon 

or control.

Rulers. Click the View Ruler icon to hide 

or show the horizontal and vertical rulers. 

Use the controls on the horizontal ruler to 

set or change tab stops and indents for the 

currently selected paragraph(s). The vertical 

ruler is visible only on the document page 

that contains the text insertion mark. 

Styles pane. To make it easier to apply a Word 

character or paragraph style to selected text, 

you can display the Styles pane by clicking the 

launcher icon at the bottom of the Styles group 

on the Home tab. Click a style name to apply 

it to currently selected text.

Office Clipboard. The Office Clipboard is 

shared among Office applications and allows 

you to copy and paste multiple items within a 

document, between documents, and even 

between applications. To show the Office 

Clipboard pane, click the launcher icon at the 

bottom of the Clipboard group on the Home 

tab. Click the pane’s close box (X) to dismiss 

the pane.

Document. Most of Word’s window is 

reserved for the current word-processing 

document. You can close the Office Clipboard 

and other panes to increase the display area 

for the document.

Scroll bar and scroll box. You can click in 

the scroll bar or drag the scroll box to navi-

gate through a document’s pages.

Figure 4.3 Click text links in Word Help to view help 
topics. Click the close box (X) or exit Word to dismiss 
Word Help.
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Page indicator. This indicator displays the 

current page number, as well as the total 

number of pages in the document. Click the 

indicator to open the Find and Replace dialog 

box to the Go To tab (Figure 4.4).

Words indicator. This indicator shows the 

word count for the document. If text is selected, 

it shows the number of words in the selection. 

Click the indicator to open the Word Count 

dialog box (Figure 4.5).

Proofing indicator. This indicator shows 

if there are proofing errors that need to be 

addressed, such as misspellings, repeated 

words, or extra spaces between words. Click 

the indicator to move from one suspected 

error to the next. 

View controls. Click an icon to switch views 

(Figure 4.6). You can also switch views by 

clicking the View tab and then clicking an icon 

in the Document Views group. The purpose 

of each view is explained in the next section.

Zoom controls. Change the current magnifi-

cation by dragging the slider, clicking the 

+ (increase) or – (decrease) button, or clicking 

the zoom percentage icon.

Close. Click the close box (X) to close an 

open document or to quit Word. (When the 

current document is the only one that’s open, 

clicking the close box quits Word.) You can 

also close the active document by clicking 

Close in the Backstage (see Figure 4.2).

✔ Tip

■ Any Word pane, such as Styles or the 

Navigation Pane, can be displayed as a 

docked pane or a floating palette. To make 

a docked pane float, drag it by its title bar 

to a new location. To dock a floating pane, 

slowly drag it off either side of the docu-

ment window until it snaps into place. 

Figure 4.4 On the Go To tab, you can go to a specific 
page by entering a page number and clicking Go To.

Figure 4.5 For detailed word count information, open 
the Word Count dialog box.

Print Layout

Full Screen Reading

Web Layout

Outline

Draft

Figure 4.6 You can quickly change views 
by clicking an icon at the bottom of the 
document window.
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Working in Different Views
Depending on what you currently want to do 

with a document, you can work in any of 

Word’s views: Print Layout, Full Screen Reading, 

Web Layout, Outline, and Draft. Each view 

serves a particular purpose, as described below. 

To switch views, you can click an icon in the 

status bar (see Figures 4.1 and 4.6) or click an 

icon in the Document Views group on the 

View tab (Figure 4.7).

Print Layout view
Standard documents, such as letters, memos, 

and reports, are often written and edited in 

Print Layout view. One advantage of working 

in this view is its adherence to WYSIWYG 

(what you see is what you get). The margins, 

headers, and footers correspond to the printed 

output. Pages are shown as equivalent pieces 

of paper with physical breaks between pages.

Full Screen Reading view
If want to read or review a document, Full 

Screen Reading view (Figure 4.8) can help 

simplify the task. 

To control Full Screen Reading view:

1. Do any of the following:

▲ To show single pages or pairs of facing 

pages, choose Show One Page or Show 

Two Pages from the View Options menu 

(Figure 4.9).

▲ To preview the pages as they’ll print, 

choose Show Printed Page from the 

View Options menu.

▲ To change the text magnification, 

choose Increase Text Size or Decrease 

Text Size from the View Options menu.

▲ To enable or disable editing, choose 

Allow Typing from the View Options 

menu.

continues on next page

Figure 4.7 The Document Views group contains the 
same five view icons as the ones in the status bar.

Figure 4.9 View Options menu.

View OptionsPage controlMisc. controls

Figure 4.8 Full Screen Reading view is especially 
useful for proofing documents, as well as reading 
ones you download or receive as email attachments.

Exit
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▲ To change pages, click an arrow but-

ton at the bottom of any page; click 

the left or right arrow icon in the 

Page controls; or press an arrow key, 

Y, or U.

▲ To go directly to a page, click the Page 

control and choose a command from 

its menu, such as Go to First Page, Go 

to Last Page, or Go To (Figure 4.10).

▲ If you’re reviewing a document, you 

can choose Track Changes commands 

from the bottom of the View Options 

menu (see Figure 4.9). 

▲ Choose other commands from the 

icons in the upper-left corner of the 

screen (Figure 4.11).

2. To exit Full Screen Reading view, click the 

close box (X) in the upper-right corner of 

the screen or press q.

Web Layout view
Use Web Layout view to create, view, and 

edit pages as they’ll appear online when 

opened in a browser. By choosing Save As in 

the Backstage, you can save pages in several 

Web-compatible formats.

Outline view
Use Outline view to create, view, and edit 

outlines. (The initial table of contents for 

this book was created in Outline view.) For 

information about working in Outline view, 

see Chapter 6.

Draft view
Work in Draft view when speed is of primary 

importance. In Print Layout view, physical 

pages and breaks are drawn. Draft view 

displays a document as a continuous text 

scroll; page breaks are denoted by dashed 

lines. Because repagination occurs almost 

instantly as you compose, this is an ideal 

view if you have an older, slower computer.

Print

Save Highlighting Comments

Figure 4.11 Click an icon to highlight selected text, 
add a comment, save changes, or print.

Figure 4.10 Navigation commands can be 
chosen from the Page control drop-down menu.
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Managing Windows
When you create a new Word document or 

open an existing document, each one opens 

in a separate window. Because it’s common 

to work with several documents at once, Word 

provides window-management commands 

in the Window group of the View tab (Figure 

4.12, below). 

To manage open document windows:

◆ Do any of the following:

▲ To create another instance of the cur-

rent document, click the New Window 

icon. Edits made in any instance of a 

window affect the document. 

 Each new instance has the same 

name as the original, followed by a 

colon and a number. For example, a 

new instance of memo.docx would be 

named memo.docx:2.

▲ To bring a document to the front and 

make it the active document, choose its 

name from the Switch Windows menu 

(Figure 4.13). 

 Because every open Word document 

is represented by a taskbar button, you 

can also switch documents by clicking 

the appropriate taskbar button.

▲ To view all open documents at the 

same time, click Arrange All. The 

documents are displayed in a stack 

(Figure 4.14) or side by side. To work 

in one of the windows, click in the 

document to make it active.

continues on next page

Figure 4.12 The Window group (View tab).

Figure 4.13 You can make any open document active 
by choosing its name from the Switch Windows menu.

Figure 4.14 Arrange All enables you to see and work 
with multiple open documents.
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▲ To work with a pair of open docu-

ments, click View Side by Side. If more 

than two documents are open, the 

Compare Side by Side dialog box 

appears (Figure 4.15). Select the 

second document and click OK.

▲ When working in View Side by Side 

mode, you can make the two docu-

ments scroll together by clicking the 

Synchronous Scrolling icon. This 

feature is useful for comparing two 

versions of the same document.

▲ To close the active Word document, 

click its close box (X), press a4 or 

cW, or click the File tab and then 

click Close in the Backstage.

▲ To close a Word document (regardless 

of whether it’s the active document), 

you can right-click its taskbar button 

or right-click any blank spot in its title 

bar and choose Close from the context 

menu that appears (Figure 4.16). 

✔ Tip

■ If you’re running Windows 7, taskbar 

buttons are different from earlier versions 

of the operating system (OS). If you have 

multiple Word documents open, they are 

grouped together within a single Word 

taskbar button. To close one of the open 

documents, rest the cursor over the Word 

taskbar button, move up to highlight the 

document you want to close, and click its 

close box (X) (Figure 4.17). As in earlier 

versions of the OS, you can still right-click 

the document name and choose Close 

from the pop-up menu that appears.

Figure 4.15 After clicking the View Side by Side icon 
in the first document window, you’ll be asked to 
select the comparison document (if more than two 
documents are open).

Figure 4.16 You can close any document or 
application in the taskbar by right-clicking its 
button and choosing Close from the pop-up menu.

Figure 4.17 In Windows 7, documents of the same 
type are grouped within an application taskbar 
button.

Word taskbar icon

Close the document
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Setting Display Options
In addition to using the zoom controls to 

change the magnification (see “Setting the 

Magnification” in Chapter 2), you can show 

or hide the following elements in the document 

window by clicking check boxes in the Show 

group on the View tab (Figure 4.18):

◆ Ruler. Use the ruler to position objects, 

set paragraph indents, and set tab stops.

◆ Gridlines. When enabled, each page is 

overlaid with a visible grid (Figure 4.19). 

Placed objects automatically snap to the 

nearest grid intersection.

◆ Navigation Pane. In Word 2010, the 

Navigation Pane (Figure 4.20) replaces 

the Document Map. Use the Navigation 

Pane to move directly to a specific docu-

ment page, heading, or search result. For 

instructions, see “Using the Navigation 

Pane,” later in this chapter.

To show/hide rulers:

◆ Do either of the following:

▲ On the View tab in the Show group, 

click the Ruler check box.

▲ Click the View Ruler icon at the top of 

the vertical scroll bar (see Figure 4.1).

To show/hide gridlines:

◆ On the View tab in the Show group, click 

the Gridlines check box.

To show/hide the Navigation Pane:

◆ On the View tab in the Show group, click 

the Navigation Pane check box. To switch 

among viewing document headings, page 

thumbnails, and search results, click a tab 

at the top of the Navigation Pane. To close 

the pane, click its close box (X) or remove 

its check mark from the Show group 

(Figure 4.18).

Figure 4.18 Click check 
boxes in the Show 
group to enable or 
disable display options.

Figure 4.19 Gridlines 
can make it easier to 
place objects.

Figure 4.20 Use the Navigation Pane to quickly 
move to a desired spot in a document.
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Entering Text
If you’ve previously used a word-processing 

program, you’re already familiar with the 

basics of entering text. On the other hand, if 

you’re new to word processing, you’ll need to 

know the following information.

To enter text:

1. Create a new document or open an exist-

ing document.

2. Do one of the following:

▲ New document. The text insertion 

mark is automatically positioned at 

the top of the first document page 

(Figure 4.21).

▲ Existing document. The text inser-

tion mark is set at the beginning of the 

document. Scroll to the page where 

you want to begin entering new text, 

such as the end of the last page. Click 

to set the text insertion mark.

3. Type your text.

Entered text appears at the text insertion 

mark. In a new document, the text is 

formatted with the default font and the 

paragraphs are left-aligned.

4. As you type, text automatically wraps as 

needed to fit within the current paragraph’s 

margins. When you want to begin a new 

paragraph, press e.

✔ Tips

■ For information on changing character or 

paragraph formatting (such as applying a 

different font or centering title text), see 

Chapter 5.

■ You can add text copied from other docu-

ments to a Word document by clicking 

the Paste icon in the Clipboard group of 

the Home tab (Figure 4.22) or by pressing 

cV.

Using Click-and-Type

If you’re more comfortable working with a 

typewriter than with a word-processing 

program, you can use Word’s click-and-

type feature to approximate a typewriter.

Instead of typing from the text insertion 

mark at the top of a new document or the 

bottom of an opened document, you can 

double-click any blank spot below either 

of these points. Word sets the text inser-

tion mark at the double-clicked spot and 

automatically adds sufficient paragraph 

returns to fill in the gap above.

Text insertion mark

Figure 4.21 In a new or opened 
document, the text insertion 
mark is set at the beginning of 
the document.

Figure 4.22 To paste copied text 
from the Clipboard, click the 
Paste icon. To reveal other Paste 
options, click the arrow beneath 
the Paste icon.

Cut

Paste Copy
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Basic Text Editing
You can use any of the following techniques 

to correct errors in a document and make 

other desired changes, such as adding text. 

The techniques vary, depending on whether 

you are changing selected or unselected text.

To delete unselected text:

1. Position the text insertion mark imme-

diately to the right or left of the text you 

want to correct or remove (Figure 4.23).

2. Do one of the following:

▲ To delete the previous character (the 

one to the left), press B.

▲ To delete the next character (the one 

to the right), press d or D.

To delete additional characters, continue 

pressing B, d, or D.

3. If necessary, replace the deleted text by 

typing new characters.

To delete or replace selected text:

1. To select text (Figure 4.24) to be deleted 

or replaced, do one of the following:

▲ Set the text insertion mark at one end 

of the text to be selected, and then 

drag to or s-click the opposite end.

▲ Set the text insertion mark at one end 

of the text to be selected, and then—

while holding down s—press arrow 

keys to move to the end of the text.

▲ Double-click to select a word or triple-

click to select a paragraph.

2. Do one of the following:

▲ To delete the selected text, press d, 

B, or D.

▲ To replace the selected text, type the 

replacement text. When you begin 

typing, the selected text is deleted. 

Selecting Partial Words

If you find that you’re frequently (and 

automatically) selecting entire words when 

trying to select partial words, the reason is 

that a Word Options setting is getting in 

your way.

To change this setting, click the File tab. In 

the Backstage, click Options. In the Word 

Options dialog box, select the Advanced 

category and remove the check mark from 

When selecting, automatically select entire 

word (Figure 4.25, above). Click OK to save 

the new setting.

Figure 4.23 Set the text insertion 
mark to the right or left of the text 
you want to delete.

Selected text

Figure 4.24 Selected text is highlighted like this.

Figure 4.25 To simplify text selection, remove the 
check mark from the second check box in the Editing 
options section.
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To insert new text:

1. Position the text insertion mark where 

you want to add the new text.

You can insert new text anywhere in a 

document.

2. Do either of the following:

▲ Type the new text.

▲ Paste the new text by clicking the Paste 

icon in the Clipboard group of the Home 

tab or by pressing cV.

✔ Tips

■ You can also delete text by cutting it. Unlike 

a normal deletion, cut text is stored in 

the Clipboard (and the Office Clipboard), 

where it’s available for pasting. To cut 

selected text, click the Cut icon in the 

Clipboard group of the Home tab (see 

Figure 4.22) or press cX.

■ You can use drag-and-drop to move selected 

text from one location to another—either 

within a document or between Word 

documents. This is equivalent to perform-

ing a cut-and-paste.

■ If you want a drag-and-drop to leave the 

original text intact (working as a copy-

and-paste rather than as a cut-and-paste), 

drag the selected text using the right mouse 

button. From the context menu that 

appears at the destination (Figure 4.26), 

choose Copy Here.

■ To undo the most recent edit, immediately 

click the Undo icon in the Quick Access 

Toolbar (Figure 4.27) or press cZ. 

(Note that you can undo multiple actions 

by clicking the Undo icon’s down arrow.)

Controlling Paste Formatting

When you paste text into a Word docu-

ment, its formatting is determined by 

settings in the Advanced section of the 

Word Options dialog box. Depending on 

the text’s source and whether the styles 

conflict, either the original formatting is 

retained or the text is reformatted to match 

the surrounding text at the destination. 

However, you can override the default 

Paste formatting.

When pasting, the Paste Options icon 

appears at the end of or beneath the pasted 

text (Figure 4.28, above). Click the icon to 

choose a formatting option.

Figure 4.26 When right-
dragging text, you can 
elect to perform a copy 
rather than a move.

Undo

Figure 4.27 You can 
often reverse your 
most recent action.

Figure 4.28 Choose a formatting 
method from the Paste Options 
drop-down menu.

Paste Options icon
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Using the Proofing Tools
Word includes a dictionary, thesaurus, and 

spelling/grammar checker that you can use 

to help with writing and editing. Spelling and 

grammar can be checked on the fly (as you 

type) or run as a traditional full-document or 

selected-text check.

To look up a word’s definition:

◆ Do either of the following:

▲ If the word is in the current document, 

select it, right-click it, and choose 

Look Up > Encarta Dictionary from 

the context menu that appears.

▲ Switch to the Review tab, and click the 

Research icon in the Proofing group. 

In the Research pane (Figure 4.29), 

type or paste the word into the Search 

for box, select Encarta Dictionary 

from the drop-down list, and click the 

green arrow button.

The word’s definition is displayed in the 

task pane.

To find a synonym for a word:

◆ Do either of the following:

▲ If the word is in the current document, 

select it, right-click it, and open the 

Synonyms submenu in the context 

menu that appears. To replace the 

word, choose a synonym from the list.

▲ Switch to the Review tab, and click the 

Thesaurus icon in the Proofing group. 

In the Research pane (Figure 4.29), 

type or paste the word into the Search 

for box and then click the green arrow 

button. (If the word is preselected in 

the document, it will automatically 

appear in the Search for box.) 

 To use a listed synonym in your docu-

ment, click the down arrow beside 

the word, and choose Insert or Copy 

(Figure 4.30).

Search for text box

Reference list

Figure 4.29 The 
Research task pane.

Perform the lookup

Definitions

Figure 4.30 To use a synonym in the 
current document, click its down 
arrow and choose an option.

Click to show 
the menu
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To check spelling/grammar as you type:

1. When the Check spelling as you type pref-

erence is enabled (see the Tip at the end 

of this section), each suspected spelling or 

grammatical error is marked with a wavy, 

colored underline.

2. Spelling. To correct or dismiss a marked 

spelling error, right-click the underlined 

text and choose one of these options from 

the context menu (Figure 4.31):

▲ To accept a suggested correction (if 

any are listed), choose a replacement 

spelling from the words listed at the 

top of the context menu.

▲ Choose Ignore to skip this instance of 

the word, leaving it unchanged.

▲ Choose Ignore All to ignore all instances 

of the flagged spelling in the document.

▲ If the spelling is correct, choose Add 

to Dictionary to ensure that the word 

is never flagged again—in this or any 

other document.

3. Grammar. To correct or dismiss a marked 

grammar error, right-click the underlined 

text. Choose one of the following options 

from the context menu (Figure 4.32):

▲ Choose the suggested fix to let Word 

make the correction.

▲ Choose Ignore if you believe the 

grammar is correct or if you want to 

manually make the correction.

Possible error Mini toolbar

Figure 4.31 Right-click a marked spelling error and 
choose an option from the context menu.

Figure 4.32 Grammatical errors can be handled 
by accepting a proposed correction or by 
choosing Ignore.
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To check spelling/grammar for 
selected text or the entire document:

1. Optional: To restrict the check to a spe-

cific portion of the document, select the 

text to be checked.

2. Do one of the following:

▲ On the Review tab, click the Spelling & 

Grammar icon in the Proofing group.

 ▲ Press 7.

If suspected errors are identified, the 

Spelling and Grammar dialog box appears 

(Figure 4.33).

3. Spelling. To handle a suspected spelling 

error, do one of the following:

▲ To accept a suggested correction (if 

any are listed), select it in the list and 

click Change.

▲ To accept a suggested correction and 

apply it throughout the document, 

select it in the list and click Change All.

▲ Edit the misspelled word in the Not in 

Dictionary box and click Change.

▲ To accept the flagged word as spelled 

correctly, click Ignore Once to ignore 

this instance of the word or click Ignore 

All to ignore all instances of this word 

found in the document.

▲ To accept the flagged word as spelled 

correctly and add it to the Office user 

dictionary (so it isn’t flagged in later 

checks), click Add to Dictionary.

▲ If the flagged word is one that you 

routinely misspell this way, select the 

correct spelling in the Suggestions list 

and click AutoCorrect. The misspelling 

is added to the AutoCorrect list and 

will automatically be corrected as you 

type in future writing sessions.

continues on next page

Figure 4.33 Suspected spelling errors (top) are 
marked in red and grammatical errors (bottom) are 
shown in green. Both are displayed in context in the 
top section of the dialog box.

Correcting Letter Case Errors

Has this happened to you? You acci-

dentally press l instead of s 

and now your newly typed text reads 

SUSAN JONES. Or while entering mailing 

addresses, your assistant decides not to 

bother with capitalization. You can fix 

many such errors by choosing a correction 

from the Change Case icon’s menu in the 

Font group on the Home tab.
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4. Grammar. To handle a suspected gram-

matical error, do one of the following:

▲ Click the button labeled with the cor-

rection, such as Delete or Change, if 

one is presented.

▲ If you believe the grammar is correct 

or you intend to rewrite the text, click 

Ignore Once to ignore the flagged error.

▲ Rewrite the text in the top half of the 

dialog box and click Change.

✔ Tips

■ To set spelling/grammar checking prefer-

ences, click the File tab and then click 

Options. In the Word Options dialog box, 

select the Proofing category (Figure 4.34), 

make any desired changes, and click OK.

■ You can go directly to the Proofing section 

of the Word Options dialog box by clicking 

the Options button in the Spelling and 

Grammar dialog box.

■ Word 2010 can consider the context of 

words when performing spelling/grammar 

checks (Figure 4.35), allowing it to flag 

words that are spelled properly but are 

incorrect (distinguishing among to, too, 

and two, for example).

■ If you choose Ignore or Ignore All for a 

suspected spelling or grammar error, the 

error will not reappear in subsequent 

spelling/grammar checks. To reconsider 

such errors, click the Recheck Document 

button in the Proofing section of the 

Word Options dialog box (Figure 4.34).

■ The AutoCorrect feature automatically 

corrects common typos and misspellings 

as you type. To view or edit the current 

AutoCorrect word list (Figure 4.36), click 

the AutoCorrect Options button in the 

Proofing section of the Word Options 

dialog box (Figure 4.34). 

Figure 4.34 Set preferences for the proofing tools in 
the Proofing section of the Word Options dialog box.

Figure 4.35 Although their and to are proper words, 
Word can flag them as incorrect if you’ve enabled 
Use contextual spelling in the Proofing section of the 
Word Options dialog box.

Figure 4.36 Add words that you commonly misspell 
to the AutoCorrect list.
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Finding and Replacing Text
Using the Find and Replace dialog box, you 

can search for any text string and option-

ally replace it with another. In addition to 

performing standard text searches, you can 

search for and replace special items, such as 

paragraph characters (¶), graphics, or text 

formatted in a specific font. Note that simple 

text searches are best performed in the 

Navigation Pane, described at the end of this 

chapter.

To perform a Find:

1. On the Home tab, click the Replace icon 

in the Editing group (cH).

The Find and Replace dialog box appears, 

open to the Replace tab.

2. Click the Find tab.

3. Enter a search string in the Find what box 

(Figure 4.37).

4. Optional: To set additional options and 

criteria, click the More >> button. The 

dialog box expands (Figure 4.38): 

▲ To perform a more precise search, set 

options in the Search Options area. 

For instance, you can ensure that 

found text exactly matches the letter 

case of the search string (Match case) 

or specify the search direction (Search 

drop-down menu).

▲ To search for a special character such 

as a tab, insert it into the Find what 

box by choosing the character from 

the Special button’s menu.

▲ To find only text with certain formatting 

(such as a particular font), choose an 

option from the Format button menu.

continues on next page

Figure 4.38 You can expand the dialog box to set 
additional Find options.

Find tab Search string

Figure 4.37 To perform a simple search, enter a search 
string in the Find what box and click Find Next.

Show additional options
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5. To begin the search, do one of the following: 

▲ Click Find Next.

▲ Choose an option from the Find in 

button’s menu to restrict the search to 

a particular document component.

Word highlights the first match, if any. 

Otherwise, a dialog box informs you that 

the search text wasn’t found (Figure 4.39).

6. Do either of the following:

▲ To search for the next match, click Find 

Next. Repeat as necessary.

▲ When you’re finished, click Cancel or 

click the close box (X).

To perform a Find/Replace:

1. On the Home tab, click the Replace icon in 

the Editing group (cH).

The Find and Replace dialog box appears, 

open to the Replace tab.

2. Enter a search string in the Find what box 

and a replacement string in the Replace 

with box (Figure 4.40).

3. Optional: To set additional options and 

criteria, click the More >> button. The dia-

log box expands (Figure 4.41).

4. Do either of the following:

▲ To simultaneously replace every match-

ing instance, click Replace All.

▲ To selectively replace text after examin-

ing each possible match, click Find 

Next. Word highlights the first match, 

if one is found. Click Replace if you want 

to make the replacement, or click Find 

Next to skip this instance and go to the 

next match. Continue as necessary.

5. When you’re finished, click Cancel or click 

the close box (X).

Figure 4.39 If the search string isn’t found, this dialog 
box appears. A similar dialog box is presented after 
all matches have been found and viewed.

Figure 4.40 Enter Find what and Replace with strings.

Show additional options

Figure 4.41 You can expand the dialog box to enter 
more specific criteria.
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✔ Tips

■ Regardless of the command you use to 

open the Find and Replace dialog box, you 

can switch between Finds and Replaces 

by clicking the appropriate tab.

■ To restrict a Find or Replace to only part 

of a document, select the text before you 

execute the Find or Replace.

■ The initial direction and scope of a search 

are determined by the text insertion mark 

and your choice in the Search drop-down 

menu (Figure 4.42) in the bottom half of 

the Find and Replace dialog box. A search 

starts from the text insertion mark and 

proceeds in the direction specified in the 

Search drop-down menu as follows:

▲ If Down or Up is chosen, the search 

proceeds to the bottom or top of the 

document or selection. When the 

bottom or top is reached, a dialog box 

asks if you’d like to search the rest of 

the document.

▲ If All is chosen from the Search menu, 

the search starts from the text inser-

tion mark, continues downward until 

the end is reached, and then wraps 

around to the beginning in order to 

complete the search.

■ When you replace text without checking 

Match case (see Figure 4.41), capitaliza-

tion of the replacement text (Replace 

with) will match that of the replaced text 

(Find what).

■ It’s sometimes important to check Find 

whole words only (see Figure 4.41) when 

performing a Replace. For example, when 

attempting to replace every instance of 

John with Mike, checking Find whole 

words only will prevent Johnson from 

being changed to Mikeson.

Figure 4.42 You can 
control the search 
direction and scope.
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Entering Symbols and 
Special Characters
Some characters—especially symbols, such 

as copyright (©)—can be extremely difficult 

to type. Using the Symbol drop-down gallery 

or the Symbol dialog box, you can easily insert 

a symbol or other character from any font that’s 

installed on your computer.

To insert a symbol or other character:

1. Set the text insertion mark at the spot in 

your text where you want to insert the 

symbol or other character.

2. In the Symbols group on the Insert tab, 

click the Symbol icon.

3. Do either of the following:

▲ Choose the character from the Symbol 

drop-down gallery (Figure 4.43). The 

character is inserted into the text.

▲ Choose More Symbols to open the 

Symbol dialog box (Figure 4.44). To 

insert a character, double-click it or 

select it and click Insert. Click the Close 

button or the close box (X) to dismiss 

the dialog box.

✔ Tips

■ When inserting a character, Word uses 

the font at the text insertion mark. To use 

a different font (Webdings, for example, 

contains unusual characters not found in 

other fonts), choose it from the Font drop- 

down menu in the Symbol dialog box.

■ To use a special character throughout a 

document, insert it once, select the char-

acter, copy it (cC), and then paste the 

character (cV) wherever it’s needed.

Figure 4.43 Common symbols can 
be selected from this gallery.

Figure 4.44 To insert a symbol that isn’t in the Symbol 
gallery or one from a different font, use the Symbol 
dialog box.
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Using the Navigation Pane
As mentioned, the Office 2010 Navigation 

Pane replaces the Document Map from ear-

lier versions of Word. In addition to quickly 

jumping to important document sections by 

clicking a thumbnail or text heading, you can 

do the following:

◆ Execute Finds to locate text in the docu-

ment that marks the spot to which you 

want to go

◆ Rearrange document sections by dragging 

their headings in the Navigation Pane

◆ Search for other material, such as tables, 

graphics, equations, footnotes/endnotes, 

and reviewer comments

To open/close the Navigation Pane:

◆ To open the Navigation Pane, switch to 

the View tab and click the Navigation 

Pane check box in the Show group (see 

Figure 4.18), click the Find icon in the 

Editing group on the Home tab, or press 

cF.

◆ To close the pane, click its close box 

(X) or remove the check mark from the 

Navigation Pane check box in the Show 

group.

To go to a particular page or heading:

◆ To go to a heading, click the Headings tab 

in the Navigation Pane. In the list that 

appears (Figure 4.45), click the desired 

heading. 

Only paragraphs to which you’ve applied a 

Heading style (such as Heading 1, Heading 

2, and so on) are listed in the pane. To 

learn about Word styles, see Chapter 5.

◆ To go to a page, click the Pages tab in the 

Navigation Pane. Click the thumbnail of 

the desired page (Figure 4.46).
Figure 4.46 You can also display 
pages as graphic thumbnails.

Figure 4.45 You can jump directly 
to important headings.

Heading 1
Heading 2

Headings

Browse results
Pages
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To perform a text search:

1. Optional: To set specific search options 

(such as Match case or Find whole words 

only), click the down arrow to the right of 

the search box and choose Options from 

the drop-down menu.

The Find Options dialog box appears 

(Figure 4.47). Set options and click OK.

2. Type search text in the box at the top of 

the Navigation Pane. Word searches as 

you type. Matches are highlighted in the 

document. The contents of the Navigation 

Pane depend on the tab that’s selected:

▲ Headings. Any heading that contains 

a match is highlighted in yellow.

▲ Pages. Any page that contains a match 

is displayed; all others are hidden.

▲ Browse results. Matches are shown 

in context in the Navigation Pane 

(Figure 4.48).

3. To go to a match, do any of the following:

▲ In the Navigation Pane, click a heading, 

thumbnail, or text result.

▲ Click the up (Previous) or down (Next) 

icons in the Navigation Pane.

▲ Press e to go to the next match.

✔ Tips

■ Choose the Find, Replace, or Go To com-

mand from the upper section of the drop-

down menu to open the normal Find and 

Replace dialog box (see Figure 4.40).

■ To find non-text items in the current 

document, choose a command from 

the lower half of the drop-down menu: 

Graphics, Tables, Equations, Footnotes/

Endnotes, or Comments. To navigate 

among the found items, click the Previous 

and Next icons (Figure 4.48).

■ To end a search, click the close box (X) to 

the right of the search box or press q.

Figure 4.47 You can set the same search options that 
appear in the Find and Replace dialog box (see  
Figure 4.41).

Search string Menu

Figure 4.48 Matches are shown in a list.

Clear the search

Next
Prev
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AutoRecover options, 13, 29, 30–32
AutoSum formula, 209
axis titles, 227

B
background, chart, 226
background color, 102, 196, 345
background images, 200
Background Removal tools, 71
Backstage

in Excel, 156
opening/closing, 11
in Outlook, 291
in PowerPoint, 242
purpose of, 4

backups, 397, 399
Banded Columns/Rows option, 

215
Bcc icon, 328
Blank Page icon, 108
blank pages, 107, 108
blind carbon copies, 328
Blocked Senders list, 375
blogs, 150–151
blog service providers, 150
bookmarks, 269
borders

for documents, 104
for movies, 267
for photos, 68
for table cells, 47, 190, 196–197

Borders and Shading dialog box, 
47, 104

breaks, 105–106
brightness setting, 65

¶ (paragraph mark), 114
3-D charts, 232
3-D reference style, 202–203

A
A1 reference style, 202
absolute references, 206
access privileges, 401, 408
Account Settings dialog box, 295
action buttons, 272
Action Settings dialog box, 272
active cell, 157
active document, 83
active sheet, 157, 158
Add New Account dialog box, 292, 

293, 294
Address Book. See also contact 

records
creating contact groups in, 

322–323
purpose of, 289
searching for contacts in, 319

Adobe Acrobat, 144
Adobe Reader, 144, 277
aligning

numbers, 117
paragraphs, 115

alignment icons, 115
Alignment Tab dialog box, 112
anchors, 161
Animation gallery, 264, 265
Animation Painter tool, 7
animations, 241, 246
Appointment Recurrence dialog 

box, 384

appointments
creating recurring, 384
defined, 382
deleting, 386
modifying, 386
recording, 383
responding to reminders for, 

385
scheduling, 381
searching for, 387–388
vs. tasks, 391

archiving
files, 401, 402
messages, 306, 363

arguments, 207
arithmetic operators, 204
Arrange All command, 18, 83
Arrange By options, 351, 352, 353
artistic effects, 67
artwork, 54, 57, 59, 104
aspect ratio, 70
attachments

adding to email messages, 336
finding messages with, 356
including within calendar 

items, 390
opening, 355
previewing, 354
saving, 355–356
sending Word documents as, 

145
AutoComplete feature, 162, 328
AutoCorrect feature, 92
Auto Fill Options menu, 171
AutoFit options, 45, 188
automatic page breaks, 105
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Broadcast Slide Show dialog box, 
283

browsers. See Web browsers
bulleted lists, 118–121
Bullet gallery, 119
business cards, 320–321, 337
Business suite, x

C
Cached Exchange Mode, 288, 349
calculated columns, 216
calculations, in tables, 49, 216
Calendar button, 382
Calendar pane, 381, 382
calendars, 381–390

changing color scheme for, 386
comparing, 390
creating recurring events in, 384
deleting items in, 386
emailing, 389–390
going to specific date in, 389
modifying items in, 386
recording items in, 383
searching, 387–388
setting preferences for, 305
sharing, 390
using multiple, 388

capitalization, 91, 95
Caps Lock, 91
captions, 53
carbon copies, 328
Cascade icon, 18
case errors, 91
categories

contact record, 311
message, 369–371
task, 394

Cc box, 328
CD, packaging presentations for, 

278–279
cell addresses, 202
cell phones, viewing/editing 

documents on, 6
cell references, 202–203, 206
cells. See also tables

adding borders to, 197
applying shading to, 47
changing border properties 

for, 47
copying, 166
deleting, 167
duplicating, 170
editing contents of, 164
editing data in, 164
entering data in, 162–163
entering formulas in, 49

filling with color, 196
fitting text within, 192
formatting data in, 48, 163, 190
inserting, 166
merging/splitting, 46
moving, 165
naming, 182–183
selecting, 160–161

Cell Styles gallery, 191
Center alignment, 115
Change Case icon, 91
Change Chart Type dialog box, 225
Change Pictures icon, 73
Change Styles icon, 127
change tracking, 146–147
Change View icon, 351
character formatting

applying as you type, 124
applying to cell data, 48, 191
applying to lists, 118
duplicating, 126
in Excel, 191
keyboard shortcuts for, 126, 333
in Outlook, 333, 335
removing, 125, 335
in Word, 99, 124–126

chart elements, 224
Chart icon, 51
chart layouts, 230
Chart Layouts group, 230
chart placeholders, 253
charts, 223–237

adding/formatting text for, 
227–228

adding trendlines to, 234
changing background for, 226
changing type/style for, 225, 230
copying, 51
creating, 51, 225
customizing, 223
designing, 224
displaying data set for, 231
as floating objects, 223, 225
inserting objects in, 223
labeling data in, 227
modifying axes in, 235
modifying data in, 237
sparklines, 236
specifying new layout for, 230
switching rows/columns in, 229
ways of using, 223
working with gridlines in, 232
working with legends in, 233

chart styles, 230
Chart Styles gallery, 230
Chart Title menu, 227
Check Compatibility command, 34

circular references, 211
Clean Up Conversation dialog box, 

365
Clear Formats command, 198
clickable links, in email messages, 

338
click-and-type feature, 86
clip art, 54, 252
Clipboard

Office, 21–22, 23
Windows, 21, 23

close box, 14, 80, 157, 243
Close command, 14
cloud computing, 397
color

background, 102, 196
transparency, 66

Color Categories dialog box, 369
color fills, 215
color gradients, 102, 215
color saturation, 66
color scales, 194
color tone, 66
columns. See also tables

adding/deleting, 46, 168, 169, 
220–221

calculated, 216
formatting, 215
inserting breaks in, 106
selecting, 47, 221
setting width of, 188, 189
sorting, 180–181, 218
switching with rows, 229
in Word documents, 100

Column Width dialog box, 188
Combine command, 149
Combine Documents dialog box, 

149
comma-delimited text files, 175
command menus, 16
comma-separated text files, 175
comma-separated value files, 176
Compare Documents dialog box, 

148
Compare Side by Side dialog box, 

84
comparison operators, 204
Compatibility Checker, 29, 34, 148
Compatibility Pack, Microsoft 

Office, 144
compression algorithms, 402
Compress Picture command, 72
concatenation operator, 204
conditional formatting, 190, 

194–195, 197
Confirm Password dialog box,  

184
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constants, 170, 202, 204
contact groups, 322–323
contact records, 309–323. See also 

Address Book
adding email addresses to, 314
adding photos to, 314
adding to contact group, 

322–323
categorizing, 311
creating, 311–314
creating business cards from, 

320–321
deleting, 314
editing, 314
for Hotmail/Windows Live 

accounts, 312
importing/exporting, 313–314
information stored in, 309
saving, 311
searching for, 318–319
viewing, 312, 315–317

Contacts button, 310
Contacts window, 309, 310
contextual tabs, 17
contrast setting, 65
conversations

components of, 352
ignoring, 365
managing, 365
viewing, 8, 352

Conversation view, 8
Convert icon, 34
Convert Text to Table command, 

43
Convert to Range icon, 214
copy-and-paste

in Excel, 166, 199
in Office 2010, 23
in Word, 86

Copy Items dialog box, 366
Copy to Folder dialog box, 279
cover pages, 107
Create button, 11
Create New Folder dialog box, 367
Create Sparklines dialog box, 236
Crop icon, 69
cropping photos, 69–70
CSV files, 176
currency, 193
Customize Keyboard dialog box, 

28
customizing

Office, 24
Quick Access Toolbar, 25
Ribbon, 26–27
Word keyboard shortcuts, 28

Custom Sort command, 181

cut-and-paste
in Excel, 165, 221
in Office 2010, 23
in Word, 88

D
data

adding/deleting, 44, 162–163, 
237

editing, 164, 237
filtering, 181, 218, 219
finding/replacing, 177–179
formatting, 48, 163, 187–200
importing/exporting, 172–176, 

313–314
invisible, 33
labeling, 227
merging with form letter, 

131–136
protecting, 184–186
sorting, 180–181, 218
summarizing, 234

data arrays, 180–181
data bars, 194
database programs, 176
databases, 213
Date and Time dialog box, 112
Date & Time icon, 257
default font, 125
definitions, dictionary, 89
Deleted Items folder, 364
Delete Sheet commands, 221
delimiter characters, 176
delivery receipts, 344
density, 66
Depth Gridlines submenu, 232
Desktop, opening documents 

from, 13
dial-up connections, 301, 304
dictionary, 89
Different First Page check box, 113
Different Odd & Even Pages check 

box, 113
digital signatures, 36
dissolves, 241
Distribute Columns icon, 45
Distribute Rows icon, 45
distribution lists, 322
.doc files, 144
document formatting, 99, 100
Document Inspector, 29, 33, 148
document-management tools, 

29–37
Document Map, 85, 97
Document Panel, 37
document properties, 29, 37

documents
adding cover page to, 107
adding headers/footers to, 

109–113
adding pictures to, 53
arranging in cascade fashion, 18
backing up, 397, 399
changing magnification of, 20
changing paragraph/line 

spacing in, 122–123
closing, 14, 77, 84
combining, 149
comparing, 84, 148
creating, 11–12, 404
creating new instance of, 18, 83
displaying open, 18
dividing into sections, 106
editing, 397
emailing, 144, 145
encrypting, 36
formatting, 99–136
inserting blank page in, 107, 108
inserting breaks in, 105–106
inserting tables in, 42–43
marking as final, 35
merging two, 131
opening, 12–13
pasting Office Clipboard items 

into, 21
printing, 15
protecting, 35–36
publishing as blog entries, 150, 

151
restoring previous versions of, 31
saving, 13–14, 29, 30, 406–407
setting indents in, 116–117
sharing, 29, 143–151, 397, 408
splitting into parts, 19
tracking changes in, 146–147

Document Views group, 81
.docx files, 144
domain names, 289, 375
double-clicking, 11
double-spaced text, 122
downloading files, 402
Download Pictures command, 350
Drafts folder, 344
Draft view, 82
drag-and-drop

in Excel, 165, 221
in Office 2010, 23
in Word, 88

drawing canvas, 56
Draw Table command, 43
Draw Table tool, 47
DVD, packaging presentations for, 

278–279
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E
EBCs, 320–321
Edit Name dialog box, 183
Edit Quick Step dialog box, 379
Electronic Business Cards, 

320–321
electronic mail, 287. See also 

email
email. See also Outlook

accounts (See email accounts)
addresses (See email addresses)
attachments, 301, 336, 354–356
clients, xii, 287
defined, 287
messages (See email messages)
sending calendars via, 389–390
sharing Word documents via, 

145
Web-based, xii, 288, 298, 300

email accounts
accessing with Web browser, 

289
adding, 292–294
changing settings for, 295–296
checking malfunctioning, 296
creating, 289
deleting, 296
setting default, 296
setting junk-mail options for, 

374–375
specifying default signature 

for, 343
types of, 288
working with profiles for, 

297–298
email addresses. See also Address 

Book
blocking, 375
components of, 289
finding, 310
letter case in, 289
representing spaces in, 289
storing in Address Book, 289

email messages, 325–380
adding signature to, 305, 343
applying theme/stationery to, 

345–346
archiving, 306, 363
avoiding unwanted, 298
backing up, 378
categorizing, 369–371
changing view for, 351
checking for new, 348
checking spelling in, 340–341
copying, 366
creating, 327–331

creating contact records from, 
312

deleting, 362–364
flagging, 361, 372–373
formats for, 332
formatting, 333–335
forwarding, 330–331
inserting items in, 337–339
marking as read/unread, 350, 

360–361
moving, 366
organizing into folders, 367–368
printing, 357–358
reading, 349–350
recalling sent, 331
replying to, 329–330
requesting receipts for, 344
resending, 331
saving as drafts, 344
searching, 291, 353
sending, 325, 330
setting preferences for, 305–306
setting priority for, 344
spell-checking, 305
types of, 326
working with attachments to, 

336, 354–356
E-mail Options dialog box, 

374–375
embedded objects, 223
embedded videos, 269
Enable Editing button, 408
Encarta Dictionary, 89
Encrypt Document dialog box, 

36, 184
encryption, 184
Eraser tool, 47
Eudora, 314
Evaluate Formula dialog box, 211
events

defined, 382
deleting, 386
modifying, 386
recording, 383
responding to reminders for, 

385
searching for, 387–388
setting recurring schedule for, 

384
Excel, 155–237. See also 

workbooks; worksheets
adding total rows in, 217
browser-based version of, 404
cell references in, 202–203, 206
change-tracking features, 147
changing default font in, 190
changing table’s size in, 220–221

creating calculated columns 
in, 216

creating charts in, 51, 225 (See 
also charts)

creating formulas in, 204–210, 
216 (See also formulas)

creating tables in, 214 (See also 
tables)

editing data in, 164
entering data in, 158, 162–163
filling cells in, 170–171
filtering tables in, 218, 219
finding/replacing data in, 

177–179
formatting features, 162–163, 

187–200, 215
importing/exporting data in, 

172–176
insertion/deletion 

considerations, 169
interface, 156–157
list-management features, 201, 

213
moving tables in, 221
naming cells/ranges in, 182–183
new features, 7
opening Office Clipboard in, 21
password-protecting 

workbooks in, 184–186
printing tables in, 222
purpose of, xi, 155
reorganizing worksheets in, 

165–169
scripts, 203
selecting cells in, 160–161
selecting rows/columns in, 221
setting magnification in, 20
setting preferences for, 158
and SkyDrive, 397
sorting table data in, 180–181, 

218
undoing actions in, 165

Exchange accounts, 8, 288, 
293–294, 300, 328, 349

Exit button, 40
exporting data, 174–176

F
fades, 269
faxes, 8, 347
fields, 213, 220
figure captions, 53
file compression, 402
file formats, 144
FileMaker Pro, 174
file management, 402–403
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file storage, online, 397. See also 
SkyDrive

File tab
in Office Web Apps, 405
in Outlook, 291
in PowerPoint, 242
vs. Office Button, 4, 11
in Word, 78

Fill Effects dialog box, 102, 196
Fill feature, 170–171
fills, 215
filtering data, 181, 218, 219
Find and Replace dialog box, 80, 

93–95, 177, 178–179
Find Options dialog box, 98
Find & Select menu, 177
Firefox, 282, 397, 399, 404
First Time Setup dialog box, 380
fixed-width fields, 176
flagging items, 361, 372–373
floating objects, 223, 225
Fly In dialog box, 265
flying text, 241
folder management, 400–401
Folder Options control panel, 11
folders, message, 366–368
Font dialog box, 6, 124, 228
fonts, 125, 228, 333
footers, 109–113, 265, 274
Format As Table dialog box, 214
Format Axis dialog box, 235
Format Cells dialog box, 192, 193, 

196–197, 215
Format Legend dialog box, 233
Format Painter tool, 126, 199, 333, 

335
Format Picture dialog box, 65, 66
formatting. See also 

character formatting; 
paragraph formatting

chart text, 228
columns, 100
conditional, 190, 194–195, 197
data, 48, 163, 190
duplicating, 126
email messages, 333–335
finding/replacing, 179
gridlines, 233
legends, 233
numbers, 193
outlines, 140
removing, 198
replacing, 199
reusing, 199
shapes, 255
sparklines, 236
tables, 215

worksheets, 187–200
X/Y axes, 235

Format Trendline dialog box, 234
form letters, 131–136
Formula Auditing group, 211
formula bar, 157
formulas, 204–210

anatomy of, 204
copying/moving, 206
creating, 208–209, 216
editing, 210
exporting, 174
filling adjacent cells with, 171
operators used in, 204
recalculating, 49
in tables, 49
troubleshooting, 211
using functions in, 201, 207
ways of using, 201

fractions, 193
Full Screen Reading view, 81
Function Arguments dialog box, 

207
Function Library group, 207, 210
functions

arguments for, 207
defined, 207
nested, 209
using in formulas, 201, 207
ways of inserting, 207

G
Gmail, 288, 294, 298, 300
Google Gmail. See Gmail
Go To Date dialog box, 389
gradients, 102, 215
grammar checker, 90–92
graphics, 7, 52, 113. See also 

artwork
gridlines, 85, 190, 232

H
handouts, 244, 246, 275
hanging indents, 116, 117
Header and Footer dialog box, 

257, 274
headers, 109–113, 257, 274
Help features

Office, 38–39
Outlook, 291, 307
Word, 79

Help icon, 38
Highlight Cells Rules submenu, 

195
Home and Business suite, x

Home and Student suite, x
Hotmail accounts

and Contacts database, 312
and Outlook, xii, 288, 294, 296, 

298
POP3/IMAP support, 298
and PowerPoint Broadcast 

Service, 282
and scheduled sends/receives, 

300
setting options for, 296
and SkyDrive, 398

HTML format, 325, 332
hyperlinks, 338–339

I
icon sets, 194
image-editing tools, 5, 52, 64–73
images. See also photos

background, 200
inserting in email messages, 337
resetting edits for, 73

IMAP accounts, 288, 292, 293, 300, 
369

Import and Export Wizard, 313, 
314

Import Data dialog box, 176
importing data, 172–173, 313–314
Import Text File dialog box, 175
indents, 116–117
inline images, 52
Insert Cells command, 166
Insert Chart dialog box, 51
Insert Function dialog box, 207
Insert Hyperlink dialog box, 338
Insert Picture dialog box, 53
Insert Table dialog box, 42, 43
instant messaging, 398
Instant Search box, 291, 318, 319, 

353
interface

Excel, 156–157
Office Web Apps, 405
Outlook, 290–291
PowerPoint, 242–243
Word, 78–80

Internet, broadcasting slide shows 
over, 282–284

Internet E-mail Settings dialog 
box, 295

Internet Explorer, 52, 145, 282, 397, 
399, 404

Internet Message Access Protocol, 
288. See also IMAP accounts

Internet Service Providers, 288, 
353
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invisible data, 33
ISPs, 288, 353

J
Junk E-mail Options dialog box, 

374–375
junk mail, 306, 374–375. See also 

spam
Justify alignment, 115

K
keyboard shortcuts

character-formatting, 126, 333
Word, 28

kiosk mode, 280

L
landscape orientation, 100
layering commands, 258
layers, 62
layouts, chart, 230
leader character, 117
Left alignment, 115
legends, 233
letters, form, 131–136
levels, outline, 139
Line and Paragraph Spacing menu, 

122
line spacing, 122
line style settings, 68
linked objects, 223
linked videos, 269
list-management features, 201, 213
lists, 118–121, 213
Live Spaces, Windows, 150

M
macros, 203
magnification, 20
Mail Control Panel, 297
Mail dialog box, 297
mailing lists, 201, 309, 325, 361, 374
Mail Merge Wizard, 131–136
Mail Setup – Outlook dialog box, 

293
MailTips, 8, 328
mailto: links, 329, 338–339
Manage Quick Steps dialog box, 

379
Manage Versions icon, 32
manual page breaks, 105–106
margins, 100, 101
Mark as Final command, 35

Mark Complete icon, 394
masking, 71
mathematical calculations, 204. 

See also formulas
Maximize/Restore Down button, 

19
membership rosters, 201. See also 

mailing lists
Merge Cells icon, 46
merge fields, 131
merge formatting, 131–136
message folders, 366–368
message formats, 332
message lists, 291, 351, 353, 358
messages. See email messages
message threads, 352
message window, 326
Messenger, 398
Microsoft

Access, x
Excel (See Excel)
Exchange, 288 (See also 

Exchange accounts)
Internet Explorer (See Internet 

Explorer)
Office (See Office)
Outlook (See Outlook)
PowerPoint (See PowerPoint)
Windows (See Windows)
Word (See Word)

Microsoft Office Access 2003 for 
Windows, x

Microsoft Office Compatibility 
Pack, 144

Minimize button, 19
Mini toolbar, 48
mixed references, 206
mobile phones, viewing/editing 

documents on, 6
Move Items dialog box, 366
movie-clip placeholders, 252
movie-editing tools, 267–269
multi-column layouts, 106
multilevel lists, 118, 121
MySpace, 303

N
name box, 157
named ranges, 157, 183
Name Manager dialog box, 183
Navigation Pane, 7, 85, 97–98, 291
nested functions, 209
network printers, 15
New Folder command, 367
New Name dialog box, 182
New Profile dialog box, 297

New RSS Feed dialog box, 302
New Web Query dialog box, 172
New Window command, 18
New Window icon, 83
no-print zone, 101
Notepad, 99
notes

adding to calendars, 382
adding to presentations, 243, 246
printing, 243, 274
setting preferences for, 306

Notes area, PowerPoint, 242
Notes component, Outlook, 290, 

306, 327
Notes Page view, 243, 244, 246
numbered lists, 118–121
Number Format menu, 163
number formatting, 193
number styles, 109
numeric constants, 170

O
objects

animating, 264–266
changing layering of, 62, 258
floating, 52
grouping, 258
inserting in charts, 223
moving, 62
resizing, 62, 63
rotating, 62, 63
selecting, 258
setting text wrap for, 61
in slides, 258

Office 2007, 4, 11
Office 2010

applications (See Office 
applications)

basics, 9–40
compatibility issues, 34
copying/pasting in, 23
customizing, 24–28
cutting/pasting in, 23
document-management tools, 

29–37
dragging/dropping in, 23
help information, 38–39
image-editing tools, 5, 52, 64–73
launching from Web Apps, 406
learning to use, xii
new features, 3–8
personalizing your copy of, 29
sharing tools, 148
suites, x, 9
video-editing tools, 267–269
Web Apps (See Office Web Apps)
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Office applications. See also 
specific applications

closing documents in, 14
creating documents in, 11–12
launching, 10
opening documents in, 12–13
printing documents in, 15
quitting, 40
saving documents in, 13–14
using the Ribbon in, 16–17
working with windows in, 

18–19
Office Button, 4, 11
Office Clipboard, 21–22, 23, 79
Office Mobile 2010, 6
Office Web Apps, 397–408

interface, 405
launching Office from, 406
saving edits/changes in, 404, 405
and shared documents, 408
vs. other Office apps, 397, 404

OneNote, 39, 58, 397, 404
online file storage, 397. See also 

SkyDrive
OpenType fonts, 6
operator precedence, 205
operators, 204–205
Orientation menu, 100
orphans, 105
outdents, 116, 117
outlines, 137–142

changing display settings for, 
142

creating, 139
defined, 137
formatting, 140
printing, 142
purpose of, 137
reorganizing, 140–141

Outline tab, 243
Outline view, 82, 137, 138, 277
outlining applications, 137
Outlook, 287–394

adding email accounts in, 
292–294

backing up folders in, 378
categorizing messages in, 

369–371
changing account settings in, 

295–296
changing view in, 351
checking for new messages in, 

348
checking spelling in, 340–341
copying/moving mail in, 366
creating message folders in, 

367–368

creating rules in, 376–378
deleting messages in, 362–364
flagging messages in, 372–373
getting help with, 291, 307
handling junk mail in, 374–375
inserting tables in, 42–43
interface, 290–291
managing conversations in, 365
managing mail in, 359–380
managing tasks/appointments 

in, 381–394
marking messages as read in, 

360–361
message-creation options, 

344–346
new features, 8
People Pane, 303
purpose of, xii, 287
reading messages in, 349–350
searching for messages in, 353
setting magnification in, 20
setting preferences for, 305–306
Social Connector, 303
subscribing to RSS feeds in, 302
types of email accounts 

supported by, 288
using signatures in, 342–343
working online/offline in, 304
working with attachments in, 

336, 354–356
working with calendars in, 

381–390
working with contacts in, 

309–323 (See also contact 
records)

working with profiles in, 
297–298

working with Quick Steps in, 
379–380

working with send/receive 
groups in, 299–301

Outlook Express, 314
Outlook Options dialog box, 

305–306, 330
Outlook Personal Folders Backup 

tool, 378

P
Package for CD dialog box, 278
Package Presentation for CD, 241, 

278–279
Page Background group, 102
Page Borders icon, 104
page breaks, 105–106
Page Color icon, 102
Page indicator, 80

Page Layout tab, 100
Page Number Format dialog box, 

109
page numbers, 109
Page Setup dialog box, 100, 101
paper size, 100
paragraph alignment, 115
Paragraph dialog box, 116
paragraph formatting

applying to cell data, 48, 191
applying to lists, 118
in Excel, 191
in Outlook, 334, 335
in Word, 99, 114, 118

paragraph mark (¶), 114
paragraphs

aligning, 115
applying styles to, 128
changing before/after spacing 

for, 123
changing line spacing for, 122
defined, 114
indenting, 116–117

paragraph spacing, 122, 123
paragraph styles, 105, 114
Password dialog box, 185
passwords

for documents, 29, 36
for email accounts, 294, 298
for presentations, 278, 279
for workbooks, 184–186

Paste All button, 21
Paste command, 22
Paste Options menu, 88
Paste Preview, 5
Paste Special command, 199
PDF files, 144, 145, 277
People Pane, 303
percentages, 193
permissions, 36, 401, 408
personalized letters, 131
phishing, 374
photo albums, 259–260
photos. See also images

adding borders/frames to, 68
compressing, 72
cropping, 69–70
editing (See image-editing tools)
inserting in email messages, 337
removing background from, 71
replacing one with another, 73
resetting edits for, 73

Picture Borders menu, 68
Picture icon, 53
Picture Options dialog box, 150
picture placeholders, 252
pictures. See images; photos
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Picture Tools, 5, 52, 64
picture watermarks, 103, 104
PivotTables, 7
placeholders, 252–254
Plain Text format, 144, 145, 325, 

332
points, 123
point symbols, outline, 139
POP3 accounts, 288, 292, 293, 296, 

300, 301
portrait orientation, 100
poster frames, 267, 268
Post Office Protocol, 288. See also 

POP3 accounts
PostScript fonts, 6
PowerPoint, 241–284. See also 

presentations
adding/deleting slides in, 251
animating objects/text in, 

264–266
broadcasting slide shows in, 

282–284
browser-based version of, 404
change-tracking features, 147
creating presentations in, 

245–246, 248–249
delivering presentations with, 

281–284
inserting tables in, 42–43
interface, 242–243
new features, 7–8
opening Office Clipboard in, 21
previewing slide shows in, 261
printing notes/handouts in, 

274–275
purpose of, xi, 241
rehearsing presentations in,  

273
replacing placeholders in, 

252–254
saving presentations created in, 

276–280
setting magnification in, 20
setting themes in, 250
and SkyDrive, 397
switching views in, 243, 244

PowerPoint Viewer, 241
precedence, operator, 205
preferences

Excel, 158
Office, 24
Outlook, 305–306
Word, 78

presentations. See also PowerPoint; 
slide shows

adding/deleting slides in, 251
adding transitions to, 271–272

animating objects/text in, 
264–266

creating, 245–246, 248–249
creating video from, 279–280
delivering, 281–284
dividing into sections, 246, 271
including movies in, 267–269
inserting shapes in, 255
organizing slides in, 246, 270
output options for, 246
password-protecting, 278, 279
previewing, 261
printing notes/handouts for, 

274–275
rearranging slides in, 243
rehearsing, 246, 273
replacing placeholders in, 

252–254
reviewing settings for, 280
saving, 245, 249, 276–280
self-running, 280
setting themes for, 245, 248, 250
ways of viewing, 241

Presentation Views group, 244
Print dialog box, 357
Printed Watermark dialog box, 103
printing

documents, 15
email messages, 357–358
help information, 39
message lists, 358
to network printers, 15
notes/handouts, 246, 274–275
outlines, 142
previewing prior to, 15
tables, 222

Print Layout view, 81
priority, message, 344
Professional Plus suite, x
Professional suite, x
profiles, 297–298
Proofing indicator, 80
proofing tools, 89–92
properties, document, 29, 37
Protected View, 12, 408
protection, password. See 

passwords
Publish Calendar to Office.com 

dialog box, 390

Q
Quick Access Toolbar, 17, 25, 157, 

243, 291
Quick Click category, 370, 371
Quick Click flag, 372
Quick Steps, 8, 379–380

Quick Styles, 127, 334
Quick Tables, 42, 43

R
R1C1 reference style, 203
range names, 157, 183
ranges, 157, 160–161, 182–183, 

202, 215
Reading Pane, 291
Reading View, 7, 244, 246
read receipts, 344
Really Simple Syndication, 287. See 

also RSS feeds
Recall This Message command, 

331
Recent Documents list, 13
Recording toolbar, 273
records, 213, 220
recurring events, 384, 394
Redo command, 165
reference operators, 204
reference styles, 202–203
Rehearse Timings icon, 273
relative references, 171, 206
reminders, 305, 306, 373, 381, 385
Remove Background command, 71
Remove Watermark command, 104
replacing text, 93–95
reports, 106, 107
Research task pane, 89
Resend This Message command, 

331
Reset Picture command, 73
Resize Table dialog box, 221
Reviewing Pane, 147
Ribbon

customizing, 4, 26–27
in Excel, 157
minimizing/maximizing, 17
in Office Web Apps, 405
in Outlook, 291
in PowerPoint, 243
purpose of, 16
in Word, 79

Rich Text Format, 144, 145, 325, 
332

Right alignment, 115
rows. See also tables

adding/deleting, 46, 167, 
168–169, 220–221

formatting, 215
selecting, 47, 221
setting height of, 189
sorting, 181
switching with columns, 229
total, 217
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RSS Feed Options dialog box, 302
RSS feeds

deleting, 302
deleting messages from, 

362–363
grouping, 301
meaning of acronym, 287
setting update limit for, 302
subscribing to, 302

.rtf files, 144. See also Rich Text 
Format

rulers, 79, 85, 101
rules, 194, 195, 375, 376–378
Rules and Alerts dialog box, 376
Rules Wizard, 376–378

S
Safari, 282, 397, 399, 404
saturation, color, 66
Save As dialog box, 13
Save command, 30
Save Workspace command, 19
Schedule View, 8
scientific notation, 193
scope, 183
screen clippings, 6
screenshots, 58
scripts, 203
scroll bar, 79
scroll box, 79
searching

calendars, 387–388
contacts, 318–319
email messages, 291, 353
help information, 38, 39
Word documents, 7, 93–95
worksheets, 177–179

section breaks, 106
sections, grouping slides into, 271
Secure Password Authentication, 

294
Select Data Source dialog box, 237
Selection Pane, 7, 63
Send a Calendar via E-mail dialog 

box, 389
Send/Receive All Folders icon, 348
send/receive groups, 299–301
Send/Receive Groups dialog box, 

299
series data, 171
Set Quick Click dialog box,  

370, 372
Set Up Show dialog box, 280, 281
shading, cell, 47
Shading menu, 47
shapes, 55, 255, 258

Shapes gallery, 255
Shapes icon, 55
SharePoint Server, 8
SharePoint Services 4, 282
sharing documents, 143–151, 408
sharpness setting, 65
Sheet Background dialog box,  

200
sheets, 157. See also worksheets
Sheet tab bar, 157, 158
Show/Hide ¶ icon, 114
Show in Favorites command, 368
Show in Groups option, 351
Shrink to Fit option, 192
signatures

digital, 36
email, 305, 342–343

single-clicking, 11
SkyDrive, 397–408

accessing, 399, 407
connecting to Web Apps via, 

404
file management, 402–403
folder management, 400–401
Office documents and,  

406–407
opening documents stored on, 

407
saving documents to, 406–407
setting sharing permissions 

for, 408
ways of using, 397, 399
and Windows Live/Hotmail 

accounts, 398
slicers, 7
Slide Number icon, 257
slides. See also slide shows

adding action buttons to, 272
adding date/time to, 257
adding/deleting, 251
adding notes to, 246
adding transitions to, 271–272
creating, 245
duplicating, 256
grouping into sections, 271
numbering, 257
organizing, 246, 270
rearranging, 243

slide shows. See also presentations
adding transitions to, 271–272
broadcasting, 282–284
presenting, 281–284
previewing, 261
rehearsing, 273
saving, 276–280
ways of viewing, 241

Slide Show view, 244

Slide Sorter view, 244, 246, 270
Slides tab, 243
slide transitions, 246
SmartArt, xi, 57, 254
Social Connector, 303
social networking sites, 303
Sort dialog box, 50, 218
Sort & Filter icon, 219
Sort & Filter menu, 180–181
sorting

lists, 120
table data, 50, 180–181, 218

Sort Options dialog box, 181
spacing, line/paragraph, 122–123
spam, 298, 306, 350, 374–375
sparklines, 7, 223, 236
special characters, 96
spell checking, 7, 90–92, 305, 

340–341
Spelling & Grammar dialog box, 

341
Split Cells icon, 46
Split icon, 19
spreadsheet program, xi, 155. See 

also Excel
Standard suite, x
Start button, 10
static objects, 223
stationery, email, 345–346
status bar, 81, 291, 304
stock charts, 234
strings, 177
structured reference style, 203, 216
Student suite, x
styles, 127–130

adding to Quick Style set, 128
applying, 128
chart, 230
defined, 127
deleting, 130
modifying, 129
purpose of, 99

Styles pane, 79
suites, x, 9
SUM function, 201, 207
Switch Documents menu, 83
Switch Row/Column icon, 229
Symbol dialog box, 96
Synchronous Scrolling icon, 84
synonyms, 89

T
Tab Color pop-out, 200
tab-delimited text files, 175
Table icon, 42
table placeholders, 253
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tables (Excel), 213–222
adding rows/columns to, 

220–221
adding total rows to, 217
changing size of, 220–221
creating, 214
creating calculated columns 

in, 216
deleting, 214
deleting rows/columns from, 

220–221
filtering, 218, 219
formatting, 215
importing data from, 172–173
moving, 221
printing, 222
selecting, 214
selecting rows/columns  

in, 221
sorting, 218

tables (Office), 41–50
adding rows/columns to, 46
applying styles to, 47
deleting rows/columns  

from, 46
entering data in, 44
entering formulas in, 49
formatting data in, 48
inserting, 42–43
merging/splitting cells in, 46
modifying grid for, 45–47
naming, 183
selecting rows/columns in, 47
sorting, 50
ways of creating, 42

Table Style Options group, 215
Table Tools, 43, 44
tabs

alternatives to, 117
creating, 27, 117
moving, 26
removing, 117
renaming, 27
showing/hiding, 26

tab-separated text files, 175
Task Recurrence dialog box, 394
tasks, 391–394

assigning, 392
categorizing, 394
creating, 392
deleting, 394
marking as complete, 393, 394
modifying, 393–394
recurring, 394
responding to reminders 

for, 385
viewing, 391, 393

vs. appointments, 391
vs. to-do items, 394

Tasks pane, 381, 391
temperature, color, 66
templates, xi, 12, 248, 376–377,  

380
Test Account Settings dialog 

box, 293
text

adding to charts, 227
animating, 264–266
checking for spelling/grammar 

errors, 90–92
deleting, 87
entering, 86
finding/replacing, 93–95
fitting within cells, 192
flying, 241
formatting, 99, 228
inserting, 88
replacing, 87

text boxes, 60, 256
text color, 102
text concatenation operator, 204
text constants, 170
text editors, 99
text effects, 7
Text Effects command, 127
text files, 175–176
Text Import Wizard, 175–176
text insertion mark, 86
text placeholders, 252
text search, 98
text watermarks, 103, 104
text wrap, 61, 192
themes

for email messages, 345–346
for presentations, 243, 245, 248, 

249, 250
for worksheets, 200

thesaurus, 89
title pages, 107
titles, axis/chart, 227
To-Do Bar, 291, 391
to-do lists, 381, 391, 394
tone, color, 66
ToolTips, 38, 405
Top/Bottom Rules submenu, 195
total rows, 217
Track Changes Options dialog 

box, 146
transitions, 241, 246, 271–272
transparency color, 66
trendlines, 234
Trim Video command, 268
TrueType fonts, 6
.txt files, 144

U
UM, 347
Undo command, 165
Unified Messaging, 347
URLs, 338–339
user names, 398

V
vCards, 320–321, 337
.vcf files, 321
Video Border menu, 267
Video Tools tab, 267, 268
View controls

Excel, 157
PowerPoint, 243, 244
Word, 80, 81–82

View Options menu, 81
View Ruler icon, 79, 85, 101
View Side by Side icon, 84
Visual QuickStart series, ix, x
voice mail, 8, 347

W
watermarks, 61, 102, 103–104
Web Apps. See Office Web Apps
Web-based email, xii, 288, 298,  

300
Web-based presentations, xi
Web broadcasts, 282–284
Web browsers. See also specific 

browsers
accessing email accounts with, 

289, 298
editing documents with, 397

Web Layout view, 82
Web logs, 150–151
Web Query Options dialog box, 

173
Web table, importing data from, 

172–173
Widow/Orphan control, 105
widows, 105
wildcards, 178
window-management commands, 

18–19, 83
Windows

Clipboard, 21, 23
launching applications, 10
Start menu, 10
Vista, 10

Windows Live
creating account for, 398
Hotmail accounts, 288
and Outlook, xii, 288, 312
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and PowerPoint Broadcast 
Service, 282

SkyDrive (See SkyDrive)
Spaces, 150
user names, 398

Windows Media Video files, 279
WinZip, 402
WMF files, 279
Word, 77–151

adding blank page in, 107, 108
adding cover page in, 107
adding headers/footers in, 

109–113
browser-based version of, 404
change-tracking features, 

146–147
changing default font in, 125
changing line spacing in, 

122–123
character formatting in, 99, 

124–126
click-and-type feature, 86
closing documents in, 77, 84
combining documents in, 149
comparing documents in, 148
configuring for blog work, 150
creating lists in, 118–121
creating outlines in, 137–142
deleting text in, 87
editing text in, 87–88
emailing documents from, 144, 

145
entering special characters 

in, 96
entering symbols in, 96
entering text in, 86
file extensions/formats, 144
finding/replacing text in, 93–95
formatting documents in, 

99–136
getting help with, 79
inserting breaks in, 105–106
inserting new text in, 88
inserting tables in, 42–43 (See 

also tables)
interface, 78–80
managing windows in, 83–84

merge formatting in, 131–136
modifying keyboard shortcuts 

in, 28
modifying page background in, 

102–104
new features, 7
opening Office Clipboard in, 21
paragraph formatting in, 114
popularity of, 77
proofing tools, 89–92
purpose of, xi, 77
replacing text in, 87
selecting partial words in, 87
setting alignment in, 115
setting display options in, 85
setting indents in, 116–117
setting magnification in, 20
setting preferences in, 78
sharing documents created in, 

143–151
and SkyDrive, 397
specifying page settings in, 

100–101
undoing edits in, 88
using Navigation Pane in,  

97–98
version considerations, 84
View controls, 80, 81–82
working with styles in, 127–130

WordArt, xi, 59, 127, 255
Word Count dialog box, 80
Word Options dialog box, 28, 92
word-processing program, xi, 77. 

See also Word
Words indicator, 80
workbooks

creating new, 159
password-protecting, 184–186
vs. worksheets, 158
ways of using, 155

Work Offline icon, 304
worksheets

changing default font for, 190, 
198

changing order of, 159
consolidating data across 

multiple, 202–203

deleting, 159
duplicating cells in, 170
editing data in, 164
entering data in, 162–163
finding/replacing data in, 

177–179
formatting, 187–200
importing/exporting data in, 

172–176
inserting new, 159
managing, 158
naming cells/ranges in,  

182–183
renaming, 158
reorganizing, 165–169
selecting cells in, 160–161
selecting rows/columns  

in, 221
sorting data in, 180–181, 218
vs. workbooks, 158
ways of using, 213

Wrap Text icon/menu, 61, 192
WYSIWYG, xi, 81

X
X axis, 235
.xls files, 174
.xlsx files, 174
XPS files, 145

Y
Yahoo! Mail, 288
Y axis, 235
yellow dot, 56

Z
Zip archives, 401, 402
ZIP codes, 163, 180, 193
zoom controls

Excel, 20, 157
Outlook, 351
PowerPoint, 20, 243
Word, 20, 80

Zoom dialog box, 20
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